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Find and open your project 

First locate your project. You start by selecting “File” and “Open Project” (1). 

 An Open window will then appear. To the left, click on suitable project folder 

and locate your LEQM project on the right hand side. Mark your project and 

click ”Open” (2). 
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Now your are at the top level of the project. To find your specific project, you 

click on the plus symbol. When you find your project, select it, right-click and 

then select ”Open project” from the popup menu. 

 



Create a part plan 
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To create a part plan, you could either get parts from your company`s part 

database, if this is required, contact one of the LEQM key users at your 

company who will guide you - or you can also create a plan manually. 

To create a plan manually, choose “Edit”, “Add New Part Plan”, and then 

select “Part Plan”. 

A Create new Part Plan window will appear.  

Fill in the required attributes, in this example; Plan Name and Project 

name, then click OK. 

 



Customize your part plans 

 In the Plan View, plan columns can be hidden or displayed via “Plan 
columns” (1) under the View menu. Note the keyboard shortcuts! This 
setting is personal and valid for the current plan type. Consequently, a 
user can for example choose to have the Start date column visible in 
HW Plans and hidden in SW Plans. 

 Attribute rows can be hidden or displayed via “Attribute Rows” (2) under 
the View menu. Note the keyboard shortcuts! This setting is personal 
and valid for the current plan type. 

 To change the plan date format, right-click in a plan and select “Display 

dates in week format” or “Display dates in local Windows format” (3). 

This setting is personal and valid for all plan types. 
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 The size of the structure pane to the left and the mini matrix in the lower 

part of the plan can be set by dragging or clicking on the splitter bars (4) 

 



Plan view - Set dates 

 To set a date on an activity, use one of the three available methods; 

 1) Drag the activity code to the week of choice in the mini matrix below 

 2) Type the date in the Start or Finish columns. Mind the date format!  

 3) Click on the arrow button and select a date from a calendar. 

 Note that when using Drag-and drop, the activity will be planned on the 

Friday of the chosen week. 

 A user can also choose to copy the activity deadlines (4) to the Finish 

column. To do so, right click in the plan and choose “Copy deadline date 

to finish date”. 
 

 When planning using the Start (and duration) columns, the following 

rules apply: 

– If a Start date is entered on an unplanned activity, the same date 

will be set on Finish and duration will be set to 1 

– If a Start date is added to a Finish date, the duration is set acc to 

Finish date minus Start date 

– If duration is entered to an activity with a Finish date, the Start date 

is set to Finish date minus duration 

– If a Start date or a Finish date is modified, the duration is kept 

– If the duration is modified, the user can choose whether to keep 

the start date or the Finish date 
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Plan view - Gantt chart 

 The planning is visualized in the plan Gantt chart. Project milestones 
are visible as vertical blue lines (1) and the displayed time span can be 
adjusted with the date buttons above (2).  

       To view the complete time span in the window check the box “Fit Gantt 
Chart in Window” (3). Note that the planning can be adjusted directly in 
the Gantt chart by moving and adjusting the triangles and bars (4).   
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Plan view - Copy activity data to other plans 
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Planning (dates, N/A and Status) and other activity data can be distributed 

from one plan to other plans. Right click on the plan you like to copy from, 

select “Copy activity data to other plans”. A Copy activity data window will 

appear. First select what kind of data that should be copied (1). Then 

select the activities to copy from (2). Note the option ”Select All”. Finally 

select the plans the data should be copied to (3) and click OK. 

 



Plan view - Insert custom activities 

 Undo/Redo planning (9) 

 Change the order of the activities (10) 

 Remove a custom activity (11) 

 View the activity explanation (12) 

 Activate/Deactivate a base/slave plan (13) 

 Freeze Proposed dates (14) 

 Copy deadline dates to Finish column (15) 

 Clear all planning on an activity (16) 

 Print a plan to paper or to Excel (17) 

 Highlight an activity in bold letters (18) 

 Change the date format (19) 
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 Custom activities can be distributed to other plans by right click - ”Copy 

activity to other plans” (5). Select which activities (6) should be copied 

to which plans (7). Click OK (8). 

Plan view - The right click menu 
By right clicking in a plan, a user can also 

2 

4 

3 
7 

6 8 

9 

10 
11 

12 

13 

14 

15 
16 

17 
18 

19 

1 

5 

To insert a new activity into a plan (Custom activity), right click on the line 

in the plan where it should be placed and select “Insert custom activity” 

(1). Enter the activity name (2) and (optional) modify the auto generated 

activity code (3). Click Create new (4). 



Plan view - Planning Support 

 In VPL, logic constraints can be created between a plan activity and a 
project deadline/milestone or to another plan activity. This could for 
example be that plan activity A should be completed 2 weeks before 
project deadline X, or that plan activity B should be completed before 
the start of plan activity C. The planning logic column (1) indicates 
whether the planning of an activity meets its logic constraint or not. 

 - Green color -> The logic constraint is met 

 - Yellow color -> The activity is not planned/Cannot validate 

 - Red color -> The logic constraint is not met 
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 A click on an exclamation mark in the Planning logic column displays a 
short explanation of the logic constraint. A double click leads to the 
Planning support window (2). This view can also be accessed by 
clicking on the puzzle button (3). 
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Plan view - General rules and pointers 
 A) Confirm the planning by setting the status to OK when an activity has 

been successfully performed. If the activity has started, set the status to 

Ongoing. Unconfirmed dates are highlighted with yellow color. 

 B) Mark activities that are not applicable (and will not be performed) 

with an N/A 

 C) Enter a comment in a comment field when planned activities are late 

in relation to the project plan or when other important information should 

be communicated to other users 
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Plan view - Planning Support/Critical path 

 In the Planning support window, the activities with a logic constraint are 
divided into three groups corresponding to the three statuses (Invalid, 
Cannot Validate & Valid). In addition to identifying the invalid planning, 
it is also useful to study the valid planning and especially when sorting 
on the column Margin. Then the planning that is valid but has a tight 
margin can be analyzed (1). This helps the user to identify the critical 
path of the project. Note the possibility to sort and filter the data (2). 
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 Two or more plans can be connected to create a Base-Slave relation. A 

Base-Slave connection keeps the slave plan(s) automatically updated 

when the base plan is modified until the connection is removed.  

 To assign a Base plan to a plan, click on the attribute Base Plan (1). 

Locate the project (2) in which the Base plan is located, mark the plan 

(3) and click OK.  
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 To assign Slave plans to a plan, 

click on the attribute Slave Plan 

(4). Locate the project (5) in which 

the slave plans are located, mark 

the plans (6) and click OK. 

  

Plan view - Base- and Slave plans 

 To deactivate a Base-Slave connection, right click in the plan and select 

”Deactivate Base plans… ” or ”Deactivate Slave plans… ” (7). 

 Connecting two (or several) plans as Base-Slave can save a lot of time 

when keeping the planning updated. However, the user has to be sure 

that the plans should have identical planning on all activities before 

connecting. 
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Access rights 

 To edit the access rights for a plan, select the plan and click on the key 

symbol (1) in the left side toolbar. In the security window that appears, 

click “Add User” (2) to add a user to the access list. Click Remove (3) to 

remove a user. A user with Write rights is allowed to update the 

planning. Change-rights allows a user to edit the access settings. 

   

 If a user requires write access to a 

plan and none of the users with 

change rights are available, contact 

one of the LEQM key user at your 

company.                 To add a user to all plans in a project, right click on any of the 

plans to the left and choose ”Add User To All Plans”. Find the user and 

click OK. 
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Custom Structure 
 A user can select plans in the database and put them in the personal 

Custom Structure (4) for easy access. No other users are affected by 

this and most of the VPL functionality is available also in 
 Custom Structure.  

 To add plans to the Custom 

Structure, click on the button (5) 

in the toolbar. The button (6) 

allows the user to search the 

database for plans and then add 

them to the Custom structure.  

 To remove plans, click on the 

button with a red minus sign (7). 
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Activity Status 

 In the tab Activity Status (1) the plan activities are grouped into 11 

different categories (2). These are: 

 Not planned - activities without any planned date 

 Not OK - activities with status Not OK 

 Not confirmed - activities with an unconfirmed start- or finish date 

 Invalid planning against project milestone - activities with planning that fails to meet a 

logic constraint set against a project milestone 

 Invalid planning in plan - activities with planning that fails to meet a logic constraint 

set against another plan activity 

 Proposed date - activities with dates planned in the proposed date columns 

 Ongoing - activities with status Ongoing 

 Due later - activities with start- or finish dates planned today (only unconfirmed) or 

later.  

 Deviation agreed - activities with an approved deviation 

 N/A - activities marked as Not applicable 

 OK - activities with status OK 

 

 

 

 

 

 

 

 

 

 

 

 

 Set a plan type filter with drop down menu (3) and add attribute filters 

with button (4). With the button “Select Visible Columns” (5), a user can 

select which columns should be visible in the matrix. Print the matrix 

(only expanded groups) with button (6). Note that all settings and 

activated filters are saved if the application is restarted!  
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Part Status matrix 

 The Part Status matrix (1) is used to display plan data and planning 

status in a list format. By clicking on the button "Select Visible Columns" 

(2) it is possible to select which columns should be visualized in the 

matrix. The types of columns are Standard columns, Attribute columns 

and Activity columns.  

 The status matrix can be sorted based on the values in the columns by 

clicking on the column headers, e.g. part number or component owner 

(3). The order of the columns can also be adjusted by dragging the 

column headers sideways. 

 

 

 

 

 

 

 

 

 

 

 

 

 The information in the Activity columns can be edited directly in the 

status matrix. To do so, double click in a cell (4) and type the date in 

format YYWW.D. After the date, and OK, Not OK or Ongoing status can 

be added. Note that editing in an Activity column cell is only possible 

when the user has Read/Write access in the current plan and when the 

activity is not slave connected. 

 The data in the status matrix can be filtered by plan type or attribute 

data (5). Add and remove attribute filters with the button “Add Attribute 

Filters” (6). 

 To export a matrix to Excel, click on the button “Export to Excel” (7). 
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Chart - Part- and Verification Status 

 In the Chart tab (1), the status for the part planning and verification 

planning can be analyzed on a high level with the Part- and Verification 

status diagrams. These views display the status for the color coded 

activities in the plans (normally the most significant ones). In the drop 

down menu “Status Type” (2), choose Part Status or Verification Status 

and then select diagram type, Graph or Pie, with the buttons (3). 

 The graph diagram displays the status over a time span which is set 

with the controls (4). Note that a project milestone can be used as a 

“date” and that a date can be set with an offset.  

 The number of plans included in the graph is listed on the y-axis and 

the project milestones are visible as vertical blue lines. A vertical red 

line shows todays date in the graph. The data included in the diagram 

can be filtered on plan type or attribute value (5). A link to the diagram 

can be generated with the button “Create LEQM Link” (6)  

  

  

 By clicking in the graph on a certain week, the status for this date is 

displayed in a pie chart. 
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 The Pie chart displays the status at a given date. Most functionality, 

including the date settings, the filter options etc., are the same as for 

the graph diagram. By clicking on a pie sector, the plans it contains will 

be displayed in a status list. 

  

 If the Unconfirmed check box (1) is activated, a grey sector (2) 

containing the unconfirmed plans will appear in the pie diagram. A plan 

is considered unconfirmed if it contains one or more planned activities 

whose start- or due date is passed (compared to the selected pie date) 

while the status is not marked Ongoing/OK. Unconfirmed plans should 

be avoided when possible! 
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Chart - Part- and Verification Status (cont.) 
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Confirmation level 



 By selecting "Part Activities" or "Verification Activities“ in the drop down 

menu “Status Type” (1) it is possible to analyze the planning of an 

individual activity from the part- or verification plans. Choose an activity 

in the drop down menu “Activity” (2).  
 

 In the Part Activities diagram below, showing the status for the activity 

PPAP Phase 3, the date is set to “Today” and the “Unconfirmed” check 

box is selected. The following analysis can be made: 
 

• 28 parts have confirmed a successfully completed PPAP Phase 3 

(Green) 

• 3 parts are over due/unconfirmed. (planned to be completed but 

not yet confirmed) (Grey) 

• 2 parts have completed the PPAP Phase 3 activity but with a Not 

OK result (Red) 

• 1 part has the PPAP Phase 3 activity planned in the future (Yellow) 

• 2 parts have no plan for PPAP Phase 3 (White)  
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Chart - Part- and Verification Activities 
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Status reports 

 In VPL, status reports containing pie- and graph diagrams and also 

deviations can be created. The reports can be personal custom reports, 

created by individual users, or global reports, created and published by 

an LEQM VPL administrator. To add a global report to the report library, 

click on the “Status Reports” button (1) followed by “Edit”/”Load global 

report” (2). Select the global report that should be added and click OK 

(3). 

 To view only the diagrams in the report (7), click on the Dashboard 

button (4), to see the list of deviations (8), click on “Deviations” (5) and 

to see both diagrams and deviations together, click on the “One Click” 

button (6). 
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Status reports (cont.) 

 To create a personal VPL report, click on the “Status Reports” button 

followed by “Edit”/”Create new” (1). Name your setting and click OK (2).  
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 An empty report is now created. To add pies- or graphs to the report, 

set up the diagrams and click on the green plus sign in the toolbar (3). 

To remove a diagram, click on the red minus sign (4). The content of a 

pie sector, e.g. Not Planned,  can be added to a deviation report. To add 

statuses/pie sectors to the deviation report, select the pie diagram in the 

list and click on “Create Deviation reports” in the toolbar (5). Select 

requested types of deviations (6) and click OK. 
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Status reports (cont.) 

 In the Status Reports setup 

window, it is also possible to 

rename a diagram or deviation 

(1), add columns with attribute 

data to the Deviation reports (2) 

and also to copy these attribute 

columns to all deviations (3). To 

delete a custom report or 

remove a global report from the 

report library, click Delete/ 

Remove (4) under the Edit 

menu. 

 In the area below the displayed report (5), the current Dashboard, 

Deviation report or One Click report can be exported to Excel, added to 

an email or added to a subscription (see next page). It is also possible 

to generate a link that can be shared with other users. By clicking on 

this link, VPL will start up and the current report will be displayed. The 

report will also be added to the report library of the receiver. 
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 The Dashboard, Deviation report and One Click  report always show 

current, live status for the project selected in the project tree. The same 

report can be used in several different projects if it is created wisely. 

Avoid dates as pie- and graph start/stop dates as they are normally 

connected to one specific project. Instead, try to use project milestones 

or “Today” as dates.  
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Status reports - Email subscriptions 

 When a user has created a report, or loaded a global report, it is 

possible to activate an automatic email subscription of this report. To 

create and manage subscriptions, click "Subscribe" in the "Status 

Reports" window (1) or under a displayed report (2). The subscription 

window (3) can also be accessed under the “Tools” menu (4). 
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 On the left side of the subscription window, all subscriptions of the 

current user are listed (5). A subscription can be  created, deleted or 

added to an email with the buttons (5). On the right side of the window, 

the subscription selected in the list can be modified. Edit the name in 

the field (6) and set up the mailing frequency in the field (7). 

 The email addresses of the receivers of the report  should be listed in 

the field (8). Separate addresses with a semicolon. 
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 In the area “Status 

Reports” (9), the 

reports  that are 

included in the current 

subscription are listed. 

Add, Edit and Delete 

with the buttons (10). 

Note that one report 

can be listed several 

times covering different 

projects. 
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Import Supplier XML 

 Save the received XML file in an appropriate folder. Open the 

corresponding VPL Supplier plan project. NOTE! The supplier plan 

project must be opened before import. It is not enough to just mark the 

project in the project tree to the left. 

  

√ 
 Choose “Import From XML” under the File menu (1). Click on “Open 

XML” (2) and open the saved XML file. Import (3). After import click 

close (4). At import, a change log is created in the library where the 

XML file is located.  

 

  

 To be able to import an XML file, a user needs to have write access in 

all plans in the receiving supplier plan project, otherwise the import is 

denied. If the user has write access to several projects, extra care has 

to be taken so that the correct project is imported in the correct place.

  

 Checklist after import: 

 - Check the Part- and Verification Status matrices if there are any open 

plans (attribute “Plan Status”). Go through the open plans and after 

having analyzed the consequences of the suggested changes, inform 

the supplier if you accept them or not. 

 - Check confirmation level. Generally it is not acceptable with 

unconfirmed planning in an VPL report. 

 - If found necessary, look through the change log to get detailed 

information about the import. 
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Excel Export/Import 

 To create your own Excel setting, go to the tab “Excel Export/Import“ 

and click Settings. Choose either to import an existing Excel setting (1) 

or to create your own new setting (2). An Excel setting can include part 

plans or verification plans.  
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 When creating a new setting, start  

 by giving the setting a name (3).  

 Click the Add button to add the plan  

 comment field (4), attributes (5), activities (6) and activity comments  

 (7) to the setting. Save the setting by clicking on Save. 

 By right clicking on an attribute- or an activity headline, one can remove 

it from the Excel setting or move them up and down in the list. By right 

clicking on an activity, the date format can be changed from week to 

date. 

 Export the data to an Excel document via the button ”Export to Excel” 

(8). To import an Excel sheet, first make sure the Excel setting that 

corresponds to the Excel file is selected (9). Click Import from Excel (10). 

 Note that for a successful import, the dates in the Excel sheet must 

remain in the format YYWW.D or YYYY-MM-DD. New columns, rows or 

comments must also not be added in the Excel document! 
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